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Debug & Trace - Basics - Part 1 - What is a tracelog?
Overview
In North52 a trace log (sometimes called trace file) is the output of a Formula execution.  In this series of articles we will breakdown the trace logs
providing a clear understanding of:

What is inside a trace log
Where to find North52 trace logs
How to interpret trace logs
Common errors to watch out for
We will touch on relevant Microsoft platform limitations and rules (depth, timeouts, execution context, etc.)
Differences between client side and server tracing

Purpose of Trace Logs
North52 tracing has 2 primary purposes:

1. Information reporting (What the formula did and why)
2. Error reporting (What the formula did and what went wrong)

Information in a Trace Log
The trace log contains as much relevant information as we can add to it. The items found inside a trace log include:

Information about the plugin context
Stage (validation, pre-op, post-op etc.)
Message (update, create, delete, etc.)
Business Unit it is executing in
CreatedOn date and time
Primary entity it is executing against

Information about the primary entity
Any values that have changed in the transaction
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Information about the formulas that are executing
List of shortcodes
Start and stop for each formula executing
Formula description (it's business rules)
Output of individual function used in the formula

Information about the Formula itself
Source properties
Description
Shortcode
Pipeline event
Pipeline stage etc

With this information you can determine how the logic in the formula has executed and why it chose the paths it did. In later articles we will examine
this data in more detail.  
NoteNote: Each trace log belongs to a specific Formula, but if multiple Formulas are executing then you can see those Formulas and their outputs in each
trace log. This is helpful when you are trying to troubleshoot multiple executing Formulas in more complex logic.  
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Debug & Trace - Basics - Part 2 - Activating a Trace log
[TOC]

Overview
In the previous article we discussed that there are 2 types of trace logs:

Informational trace logs
Error trace logs

Error tracing is always on, so if something throws an error, North52 will attempt to tell you what happened.

Information tracing is different and must be manually turned on. It can be enabled in 2 ways:
1. At the Local level (whenever a specific formula completes successfully it will generate a North52 Trace log).
2. Globally via the North52 Configuration Record. (Whenever anyany North52 formula completes it will generate a tracelog).

Note 1:Note 1: Having North52 tracing running at the Global level and the Formula level will generate 2 trace logs for a Formula, as the trace will be generated
twice, one for the Global and one for the Local level.

Note 2: Note 2: Global tracing enabled in a production system can generate a lot of trace logs if the system is busy.

Enable Local Tracing
Open the formula and expand the deployment settings:

Set the Trace Level to Information Information
When the Formula executes, it will generate a trace log

Enable Tracing Globally
Open the North52 ConfigurationNorth52 Configuration record and locate Tracing LevelTracing Level:
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When Tracing LevelTracing Level is set to InformationInformation, every North52 Formula that executes will generate a trace log when it completes successfully
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Debug & Trace - Basics - Part 3 - Locating Trace logs
[TOC]

Informational Trace logs
In North52 informational trace logs are available in two locations:

From within the Formula form
From Trace Logs menu on the North52 App

On the Formula Form
Here you will find trace logs generated by this specific formula:

In the North52 App you can access a list of all North52 trace logs in the Dynamics instance:

Error Trace Logs
Error trace logs are made available in different ways depending on where the error occurs:

Client Side Errors
Client Side Formula's will throw an error on the screen that gives you information. However, often the most detailed error messages for these are
available via pressing F12 on your keyboard and accessing the Console tab within the Developer Tools window.

Debug & Trace - Basics - Part 3 - Locating Trace logs - Page 7 of 21Page 7 of 21

https://www.north52.com/knowledgebase/locating_traces_1.png
https://www.north52.com/knowledgebase/locating_traces_2.png


If you click Show DetailsShow Details and download the log file you can see information like shown below:

You can also access this error message in the Console tab within the Developer Tools window (pressing F12 usually):

In the above example we are trying to show a tab with a name of fake_tabfake_tab, which doesn't exist, therefore the HideShowTabs() function is failing since it
can't make something that doesn't exist visible.

Server Side Errors
Server side errors in Dynamics will throw an error that will appear on screen:
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The above is a generic error message that you will see when the Global Tracing Level (in the North52 Configuration record) is set to None. This is
designed to be a gentle 'something went wrong' for end users, instead of throwing a full stack trace onto their screen.

Unfortunately the error report generated in the Unified Interface when they download the log file isn't very helpful as it shows a Microsoft stack trace,
not a North52 trace log:

Are you able to determine what went wrong from the above error message? There is not enough information in this message - there are 2 steps to
help troubleshoot this:

Step 1: Change the North52 Configuration Tracing levelStep 1: Change the North52 Configuration Tracing level
Go to the North52 ConfigurationNorth52 Configuration record and set the Tracing Level Tracing Level to Information(Show Exception Details)Information(Show Exception Details)
Reproduce the error message following the same steps. This will produce a new error pop up with some more helpful information:

However Microsoft only allows a tiny visual window to access the error log, so you can copy it out into Notepad and read it there:

Debug & Trace - Basics - Part 3 - Locating Trace logs - Page 9 of 21Page 9 of 21

https://www.north52.com/knowledgebase/locating_traces_6.png
https://www.north52.com/knowledgebase/locating_traces_7.png
https://www.north52.com/knowledgebase/locating_traces_8.png


This is a little more readable, but it's hard to copy and paste correctly from the tiny window, and all formatting is lost in the trace log

Step 2: Enable Plugin Tracing from with System SettingsStep 2: Enable Plugin Tracing from with System Settings
Go to Settings > Administration > System Settings > Customization Settings > Administration > System Settings > Customization and set the Plug-in and custom workflow activity tracing to ExceptionException::

This means that when an error occurs Microsoft will store the trace log in Settings > Plugin trace logs Settings > Plugin trace logs::

When you open the trace log here you can see the entire output in a far more readable state:
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In this case my Formula is attempting to update a field that doesn't exist in the account, the 'faxx' field instead of the 'fax' field
Finally you can access these plugin-trace logs from within XRMToolBox using the Plugin Trace ViewerPlugin Trace Viewer by Jonas Rapp

This will allow you to examine the Plug-in Traces easier than using the viewer in the web client
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Debug & Trace - Intermediate - Part 1 - Reading a Trace
log
[TOC]

Overview
When using North52, being able to understand a trace log can help you to resolve any issues you come across during the development and testing of
your formulas.

NoteNote: There are multiple sections from different trace logs in this article, we will review each of them individually.

Plugin Context
A formula trace will start with information about the Plugin Context:

~********************* Start PlugIn Context Info ********************* UserId: 0aad6d4c-f237-44b0-9b00-8c0540d166dc
OrganizationId: 94584a47-3818-413e-bac1-26cd8a674302 OrganizationName: orgfae6242c MessageName: Update Stage: 40 Mode: 0
PrimaryEntityName: account SecondaryEntityName: none Parent PrimaryEntityName: account Parent MessageName: Update
BusinessUnitId: a0dedc30-9a91-ea11-a811-000d3ab6d424 CorrelationId: 1051106e-f92d-467f-9ee0-b08141515a54 Depth: 1
InitiatingUserId: 0aad6d4c-f237-44b0-9b00-8c0540d166dc IsExecutingOffline: False IsInTransaction: True IsolationMode: 2
Mode: 0 OperationCreatedOn: 6/11/2020 1:32:29 PM OperationId: 37cd2b04-c2b0-4f9c-8a70-df285bb222a3 PrimaryEntityId:
60ee4899-0dab-ea11-a812-000d3aba6b7b OwningExtension LogicalName: sdkmessageprocessingstep OwningExtension Name:
North52.FormulaManager.Plugins.AnyEntity.SingleFormula: account : Update : PostInsideTransaction OwningExtension Id:
f0ee7b47-98a9-ea11-a812-000d3aba6b7b SharedVariables: PrimitiveValue: IsAutoTransact: True;  

In the above, you can see the following useful information:
This is a Stage 40Stage 40 plugin - which means it executed post-operationpost-operation
The message name is Update Update - something changed on an already existing record, i.e. Not a Create or Delete Operation etc.
It was fired against the Account Account entity
It's Depth is 1Depth is 1 - this is the first step in the Execution PipelineExecution Pipeline

The more consecutive layers of logic that are triggered by this action will increase the Depth (Microsoft uses depth count to detect infinite
loops)
In online instances the max Depth allowed is 16
In on-premise instances the default is 8, but it can be raised by using PowerShell scripts

The date and timedate and time the plugin fired

You can learn more about the execution pipeline here: https://docs.microsoft.com/en-us/powerapps/developer/common-data-service/event-
framework#event-execution-pipeline

Changed Attributes (Fields)
InputParameters: Target: ********************* Entity Trace for account ********************* EntityId: a0b69702-0eab-
ea11-a812-000d3aba6b7b Attributes:[ PrimitiveValue: name: Name13; PrimitiveValue: accountid: a0b69702-0eab-ea11-a812-
000d3aba6b7b; PrimitiveValue: modifiedon: 6/15/2020 1:56:52 PM; EntityReference: modifiedby: 0aad6d4c-f237-44b0-9b00-
8c0540d166dc; ; Null parameter value for key modifiedonbehalfby ] PrimitiveValue: Target: Microsoft.Xrm.Sdk.Entity;
PrimitiveValue: ConcurrencyBehavior: Default;

In the above server-side trace snippet you can see the input parameters - i.e. What has changed. In the above the values that changed are:

name > changed to Name13Name13
modifiedon > date and timedate and time of save
modifiedby > Guid Guid of the User User who made the change

Formulas Registered for Trigger Event 
~GetFormulas: account Count: 1 : 0 ~Validate Configuration: Oty :: True :: True :: 0 ~ColumnNames: accountid :: 0
~GetSourceEntityPreValues  

These lines show how many formulas are being triggered by this server-side save event.

In this case, only 1 formula is registered to be fired: OtyOty

In the validate configuration line you can see it is listed with two boolean values. Both of these need to be true for the formula to actually execute. If
either is false, then the formula wont be triggered.

The boolean values represent if the formula is active and if the attributes that have changed will trigger it.

Debug & Trace - Intermediate - Part 1 - Reading a Trace log - Page 12 of 21Page 12 of 21

https://docs.microsoft.com/en-us/powerapps/developer/common-data-service/event-framework#event-execution-pipeline


Below you can see a portion of a trace log on a the Account entity that has many Formulas connected:

********************* End PlugIn Context Info ********************* ~GetFormulas: account Count: 14 : 0 ~Validate
Configuration: 2MQ :: True :: True :: 0 ~Validate Configuration: i22 :: True :: False :: 0 ~Validate Configuration: 3M0 ::
True :: False :: 0 ~Validate Configuration: XQK :: True :: True :: 0 ~Validate Configuration: OTb :: True :: True :: 0
~Validate Configuration: lt8 :: True :: True :: 0 ~Validate Configuration: 7Hz :: True :: False :: 0 ~Validate
Configuration: YVu :: True :: False :: 0 ~Validate Configuration: XQN :: True :: False :: 0 ~Validate Configuration: qFw
:: True :: False :: 0 ~Validate Configuration: oxG :: True :: False :: 0 ~Validate Configuration: g2W :: True :: False ::
0 ~Validate Configuration: bXn :: True :: False :: 0 ~Validate Configuration: BoM :: True :: False :: 0

However only 4 of the 14 formulas are True :: True, so it makes understanding the complex log easier.

Start Single Formula executionStart Single Formula execution
He we will cover what actually happens during function execution.

We will use the following formula for our example:

This formula is creating an auto number. The specific requirement is that the first 3 characters of the account name is used as a prefix and that when
generating the AutoNumber we need to count the number of existing prefix records and increment by one.  You can see the detailed example
here: https://support.north52.com/knowledgebase/article/KA-01066-dynamics-crm-365-xRM-Formula-062-Advanced-AutoNumber/en-us

Formula Execution
We will analyse this Formula and determine what function will execute first, and how the output of a function becomes the input for another function.

The account name here is Microsoft - UKMicrosoft - UK.

The first statement to execute will be the Left([account.name], 3)

North52 functions will execute left to right and inside out. In this example the Upper(Left([account.name], 3))  doesn't depend on anything else
executing first, but the Upper()Upper() function needs the output of the  Left([account.name], 3)  function before it can execute.

In the trace log you will see

Function Name: left Value: Mic   (the output of the Left()Left() function is Mic Mic and this becomes the input for the Upper()Upper() function)
Function Name: upper Value: MIC  (the output of the Upper()Upper() function is MICMIC)

The next function to execute will be populating the SetParams()SetParams() of the FindCountFD()FindCountFD().

Again it's an Upper(Left([account.name], 3)) , so you will see a repeat of the first two function outputs in the trace log:

Function Name: left Value: Mic
Function Name: upper Value: MIC
Function Name: left Value: Mic
Function Name: upper Value: MIC

Next the SetParams() SetParams() value will be populated with the output of the Upper( Upper() being added to a % % symbol:

SetParams( Upper(Left([account.name] ,3)) + '%' )

Function Name: left Value: Mic
Function Name: upper Value: MIC
Function Name: left Value: Mic
Function Name: upper Value: MIC
Function Name: setparams Value: MIC%
Next comes the evaluation of the FindCountFD()FindCountFD() function. In the trace log you will be able to see the Fetch-XML that was executed:

Function Name: left Value: Mic
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Function Name: upper Value: MIC
Function Name: left Value: Mic
Function Name: upper Value: MIC
Function Name: setparams Value: MIC%
FetchXml-A.: <fetch distinct='false' mapping='logical' no-lock='true' aggregate='true'>  
<entity name="account">
<attribute name='accountnumber' alias='accountnumber_count' aggregate='count' />         <filter type="and">            
<condition attribute="accountnumber" operator="like" value="MIC%" />     </filter>   </entity> </fetch>
Function Name: findcountfd Value: 3
The FindCountFD() FindCountFD() function returns a value a 3.

FindCountFD('GetCurrentAutoValue','accountnumber','0',true,SetParams( Upper(Left([account.name] ,3)) + '%' ))+1
The result of the FindCountFD()FindCountFD() is incremented by 1 giving a value of 4.

That number is then the input of the PadLeft(PadLeft() function:

PadLeft(FindCountFD('GetCurrentAutoValue','accountnumber','0',true,SetParams( Upper(Left([account.name] ,3)) + '%' ))  
+1,4,'0')
PadLeft( 4,4,'0')  is what is actually executed: Pad to the left of the value 4, with zeros until we have a 4 digit string:

Function Name: left Value: Mic
Function Name: upper Value: MIC
Function Name: left Value: Mic
Function Name: upper Value: MIC
Function Name: setparams Value: MIC%
FetchXml-A.:
<fetch distinct='false' mapping='logical' no-lock='true' aggregate='true'>  
       <entity name="account">
            <attribute name='accountnumber' alias='accountnumber_count' aggregate='count' />        
            <filter type="and">            
                   <condition attribute="accountnumber" operator="like" value="MIC%" />    
            </filter>  
       </entity>
</fetch>
Function Name: findcountfd Value: 3
Function Name: padleft Value: 0004
So now we have evaluated all function calls: 'MIC' + '-' + '0004''MIC' + '-' + '0004'

Function Name: left Value: Mic
Function Name: upper Value: MIC
Function Name: left Value: Mic
Function Name: upper Value: MIC
Function Name: setparams Value: MIC%
FetchXml-A.:
<fetch distinct='false' mapping='logical' no-lock='true' aggregate='true'>  
       <entity name="account">
            <attribute name='accountnumber' alias='accountnumber_count' aggregate='count' />        
            <filter type="and">            
                   <condition attribute="accountnumber" operator="like" value="MIC%" />    
            </filter>  
       </entity>
</fetch>
Function Name: findcountfd Value: 3
Function Name: padleft Value: 0004
Function Name: padleft Value: 0004
~Result: MIC-0004
This value is then put into the Account Number field:
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Entity Trace for north52_formula
The entity trace for the North52 formula appears next and will give you plenty of relevant information about the settings on formula that was
triggered. 

~********************* Entity Trace for north52_formula ********************* EntityId: 6d9503b9-bbab-ea11-a812-
000d3aba6b7b Attributes:[ PrimitiveValue: north52_checksum: 16D5887A6BE54E96E8E2C12902EC3061; OptionSetValue:
north52_executeas: 217890000; OptionSetValue: north52_executionprocess: 217890000; OptionSetValue: north52_pipelineevent:
217890002; PrimitiveValue: north52_formuladescription:  UpdateRecord('account',   [account.accountid],  
SetAttribute('fax', '0211234567')   )  ; OptionSetValue: north52_pipelinestage: 217890001; PrimitiveValue:
north52_deploymentsolution: North52FormulaManagerDeploymentSolution; PrimitiveValue: north52_version: 9dec3b94-c248-4d30-
8096-4effe2cb8ac4; OptionSetValue: north52_tracinglevel: 217890001; PrimitiveValue:
north52_enablefindfunctionfetchxmloptimization: True; PrimitiveValue: north52_enableprevaluecheck: False; OptionSetValue:
north52_mode: 217890002; OptionSetValue: north52_displayformat: 217890000; PrimitiveValue: createdon: 6/11/2020 8:15:34
AM; OptionSetValue: north52_formulatype: 217890013; PrimitiveValue: north52_sourceentityproperty:
name|address1_line1|address1_line2|address1_line3; PrimitiveValue: north52_sourceentityname: account; PrimitiveValue:
north52_shortcode: Oty; PrimitiveValue: north52_name: Account - Save - Perform Action - Thu Jun 11 2020 09:15:34 GMT+0100
(British Summer Time); PrimitiveValue: north52_formulaid: 6d9503b9-bbab-ea11-a812-000d3aba6b7b; FormattedValue:
north52_executeas: Calling User; FormattedValue: north52_executionprocess: Dynamics Sandbox; FormattedValue:
north52_pipelineevent: Create & Update; FormattedValue: north52_pipelinestage: Post-Operation (Synchronous);
FormattedValue: north52_tracinglevel: Information; FormattedValue: north52_enablefindfunctionfetchxmloptimization: Yes;
FormattedValue: north52_enableprevaluecheck: No; FormattedValue: north52_mode: Server Side; FormattedValue:
north52_displayformat: String; FormattedValue: createdon: 11/06/2020 08:15; FormattedValue: north52_formulatype: Save -
Perform Action; ]

Relevant pieces of information:
north52_sourceentityname  - north52_sourceentityname  - what entity the Formula is executing against
north52_sourceentitypropertyname  north52_sourceentitypropertyname  what are the triggers for the Formula
north52_pipelinestagenorth52_pipelinestage - where the event execution pipeline is the Formula going to fire
north52_formulatype north52_formulatype - e.g. Formula type: Save - Perform Action, Save - To Current Record,  Process Genie, etc.
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Debug & Trace - Intermediate - Part 2 - Client Side
Debugging
[TOC]

Overview
Sometimes it becomes necessary to perform debugging of client-side code. This would usually be needed in the following circumstances:

Allowing us to see how a Formula that is set to execute on a form [e.g. onChange() event] interacts between the web page and the server
Debugging some element related to the North52 user interface

Fiddler  
In order to perform this debugging we need a free debugging tool called Fiddler. If you do not have this installed please download
from http://www.telerik.com/fiddler

Setup Debugging
In order to perform debugging you need to start Fiddler
It should look something like the screenshot above
If the CRM system you are accessing runs under HTTPS \ SSL then go to Tools > Fiddler Options Tools > Fiddler Options and enable the 2 check boxes as shown in the
screenshot below. Note some popups will appear and you can just accept these.
Ensure that in the top left hand corner of  Fiddler that the Capture Traffic Capture Traffic is turned on

Decrypt HTTPS Traffic
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Capture Traffic

 

How to Perform Debugging
Now that Fiddler is up and running you need to navigate to the web page in CRM and perform the desired action
This could be changing the value of a field on the form which would then trigger the North52 Formula to execute
What happens then is Fiddler records this interaction so we can see all the details of what happened
You can click File -> Save -> All Sessions  File -> Save -> All Sessions to save a file which will contain this interaction
Finally you can send this file to support@north52.com to get it reviewed and a resolution to your issue
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Debug & Trace - Top 10 - Tips & Tricks
[TOC]

Overview
In this article we review a variety of common error messages and scenarios and the steps to help you begin troubleshooting.

Tip #1
Error Message
"An error has occurred in North52 FormulaManager.System.ServiceModel.QuotaExceededException: The size necessary to buffer
the XML content exceeded the buffer quota."

Resolution
The usual cause of an error like this would be when the Formula is running Post-Operation and the Formula is updating a field on the record, that is
also a trigger field for the Formula, thereby creating an infinite loop.  This will also apply if the Source PropertySource Property is set to All PropertiesAll Properties.

To resolve this error, you will need to set the Formula's Source Properties correctly.

 

Tip #2
Error Message
"An error has occurred in North52 FormulaManager"

Resolution
This error message has 2 potential causes:

    1. Some error has occurred in the Formula that is executing and the North52 Configuration North52 Configuration record Trace Level Trace Level is set to OffOff
    2. An error occurs further along the execution pipeline
        a. For example, the Formula updates a field on an Account record. There is another piece of logic that triggers on change of that field (a North52
Formula, a plug-in or a real-time workflow) and this has an error in it

To begin resolving this you could change the Trace LevelTrace Level value to Information (Show Exception Details).Information (Show Exception Details). This will display the error from the main
Formula in scenario 1, or bubble up the error message from the later executing logic in scenario 2.

 

Tip #3
Error Message
"An error has occurred in North52 FormulaManager.An exception System.FormatException was thrown while trying to convert
input value '?' to attribute 'account.primarycontactid'. Expected type of attribute value: System.Guid. Exception raised:
Guid should contain 32 digits with 4 dashes (xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx)."

Resolution
The Formula is attempting to do an UpdateRecord() UpdateRecord() and the value that is passed into the Account's primarycontactid primarycontactid field should be a GuidGuid, but
instead a ?? is being provided instead.

Usually in a FindValue()FindValue() function a '?' is set as the default if no value is found, so its likely the trace log will show this. 

It is possible that there is incomplete data in the Dynamics instance, or the FindValue()FindValue() needs to be corrected.

 

Tip #4
Error Message
Behavior: No server side Formulas are executing at all
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Resolution
It is possible that the SDK message processing steps that connect North52 Formulas to server-side events have been disabled somehow.

Follow the steps in this article to reactivate them: https://support.north52.com/knowledgebase/article/KA-01989-dynamics-crm-365-Troubleshooting-
06-Enable-SDK-Message-Processing-Steps/en-us  

 

Tip #5
Error Message
Time out Exceptions in N52 Publish All workflow
An unexpected error occurred from ISV code. (ErrorType = ClientError) Unexpected exception from plug-in
(Execute):  North52.FormulaManager.Plugins.Configuration.N52Command: Microsoft.Crm.TimeoutException: Couldn’t complete
execution of the North52.FormulaManager.Plugins.Configuration.N52Command plug-in within the 2-minute limit.

This is saying the Publish is unable to complete inside the platform 2 minute time limitation.
There are two steps you can take to resolve this:

Resolution 1
Delete Trace Logs
North52 Formulas have a parental relationship with their trace logs. Therefore if you have a Formula with hundreds of trace logs, that is is being
replaced, the delete process will cascade delete all the trace logs. This can take some time.

To resolve:
Go to the North52 AppNorth52 App
Select all existing Trace LogTrace Log records and Delete Delete them

Ideally using a Bulk Delete JobBulk Delete Job
Click Publish All CustomizationsPublish All Customizations again (to re-trigger the N52 Publish All workflow)

In most cases, this will resolve the issue for you.

Resolution 2
Lower the Publish Count
If you are still seeing timeouts, you can lower the N52 Publish CountN52 Publish Count. Please see this article: https://support.north52.com/knowledgebase/article/KA-
01995-dynamics-crm-365-Troubleshooting-12-Auto-Publishing-Publish-Count/en-us

By lowering the count, it will reduce the number of Formulas that are attempting to be published at the same time, but the publish workflow can take
longer to complete.

 

Tip #6
Error Message
Form names are different between instances
Exception type: System.ServiceModel.FaultException`1[Microsoft.Xrm.Sdk.OrganizationServiceFault] Message: The form named New
Form cannot be found. If you have renamed or deleted the form you will need to restore the form so changes can be made to
this formula.

Resolution
This error message occurs when you are trying to publish a client-side Formula that is connected to a form that doesn't exist in the target instance.
Often the form has been renamed, or maybe has been deleted entirely.

To resolve:

Correct the form name in the source instance
Modify the formulas on that form to have the correct form binding
Save and publish the Formulas
Re-export from source instance
Import into target instance and publish
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Or you could rename the form in the target instance to match the source instance (usually only applies if the form in the target instance was renamed
accidentally).

 

Tip #7
Error Message
Scheduler infinite loop
Message: This workflow job was canceled because the workflow that started it included an infinite loop. Correct the
workflow logic and try again. For information about workflow logic, see Help.

Resolution
This error message occurs when your schedule triggers Microsoft's infinite loop detection. You will need to decrease the Schedule's loop depth
tolerance so that you avoid the Microsoft error.  

To resolve:

Decrement the Max Infinite Loop Depth Max Infinite Loop Depth on the Schedule by 2
Retest Scheduler
If error persists, decrement infinite loop count again and retest
Repeat until resolved

 

Tip #8 
Error Message
Nested Exceptions
Unhandled Exception: Microsoft.Xrm.Sdk.InvalidPluginExecutionException: An error has occurred in North52 FormulaManager. 

List of the possible sources that a nested exception is being thrown:

 Another formula
 Real-time Workflows
 Custom Plug-In
 Data Integration such as Scribe, Simego, etc.

Resolution
In order to capture the nested exception we need to turn on tracing. The steps below will show you how to do this:

Navigate to the North52 ConfigurationNorth52 Configuration record
Change the Tracing LevelTracing Level to Information (Show Exception Details)Information (Show Exception Details)
Click SaveSave
Perform the action that caused the failure to see the nested exception details

 

Tip #9 
Error Message
Client-side Formula not executing upon trigger
Client-side formula not executing / bindings are not setup

Resolution
This issue doesn't come with an error but it is noticeable because client-side Formulas don't trigger when they should.

First you need to check if the bindings are set up:
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Open up the form designer for the applicable form
Open the Form's PropertiesForm's Properties

Under Form Libraries Form Libraries make sure all 3 JavaScript libraries are there: north52_/javascript/n52.jsonnorth52_/javascript/n52.json, north52_/javascript/n52.rest north52_/javascript/n52.rest and
north52_/javascript/n52.clientsidenorth52_/javascript/n52.clientside
Under Event Event HandlerHandler, make sure the expected event has north52_/javascript/n52.clientsidenorth52_/javascript/n52.clientside

For example a client-side formula on the Account Account entity that triggers on change of the description description field would have
a north52_/javascript/n52.clientside north52_/javascript/n52.clientside on Control Control equal to Description Description and Event Event equal to ChangeChange

If any of the above are missing, you will need to recreate the bindings:

Open the Formula and select N52 Command > Publish Formula N52 Command > Publish Formula
If the issue still persists, you will need to re-select the bindings
In the Formula, expand Source & TargetSource & Target and set the Source Property Source Property to any field, save and then set the Source Property Source Property back to the original field
and save again
Publish the Formula once more and retest

 

Tip #10
Complete our training courses!
We have over 10 courses with 50+ lessons available that can get you North52 certified!  The FREE online training is available
at: https://support.north52.com/training/

If you still cant find what you need, please contact support@north52.com.
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